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About this document

Scope and purpose

This application note provides an overview of the evaluation board EVAL-6EDL041065PR concerning its main
features, hardware description, thermal performance, typical waveforms, etc.

The EVAL-6EDLO041065PR board is a power drive board including driver ICs, IGBTs and signal interface. The
board isintended to drive a brushless direct current (BLDC) motor by connecting it to an external controller
board such as iMOTION™ EVAL-M1-101T.

The board aims to boost Infineon’s newly promoted 650 V three-phase gate driver with Over Current Protection
(OCP), Enable (EN), Fault and Integrated Bootstrap Diode (BSD) 6EDL04I065PR using the silicon-on-isolator
(SOI) technology.

Intended audience

This application note is intended for all technical specialists likely to evaluate the 650 V SOI gate drivers for
general applications. The board must be used only under laboratory conditions by technical specialist who
have a knowledge of motor control and are capable to handle high voltage tests.

Evaluation Board

EVAL-6EDL04I065PR is designed to evaluate the 650V SOI three-phase gate driver 6EDL041065PR along with six
Trenchstop™ IGBTs IKDO6N60RC2.

This board is to be used during the design-in process for evaluating and measuring characteristic curves, and
for checking datasheet specifications.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.
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Important notice

Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).

Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards
has been tested by Infineon Technologies only as described in this document. The design is not qualified
in terms of safety requirements, manufacturing and operation over the entire operating temperature
range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.

Itis the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.

The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions
Note: Please note the following warnings regarding the hazards associated with development systems

Table1 Safety precautions

Warning: The DC link potential of this board is up to 650 VDC. When measuring
voltage waveforms by oscilloscope, high voltage differential probes must be used.
Failure to do so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take
time to discharge after removal of the main supply. Before working on the drive
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to
do so may result in personal injury or death. Darkened display LEDs are not an
indication that capacitors have discharged to safe voltage levels.

Warning: The evaluation or reference board is connected to the grid input during
testing. Hence, high-voltage differential probes must be used when measuring voltage
waveforms by oscilloscope. Failure to do so may result in personal injury or death.
Darkened display LEDs are not an indication that capacitors have discharged to safe
voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation or reference board contains parts and assemblies sensitive
to electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: Adrive that is incorrectly applied or installed can lead to component
damage or reduction in product lifetime. Wiring or application errors such as
undersizing the motor, supplying an incorrect or inadequate DC supply, or excessive
ambient temperatures may result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that
need to be removed prior to installation. Failure to remove all packing materials that
are unnecessary for system installation may result in overheating or abnormal
operating conditions.

>R B BB
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1 The board at a glance

The evaluation board EVAL-6EDL041065PR provides a DC input and a three-phase output power for motors. It
contains the gate driver IC 6EDL04I065PR, the TRENCHSTOP™ IKDO6N60RC2 IGBTS, bus capacitors, a single
shunt for current sensing, a voltage divider for DC-link voltage measurement, and other peripherical circuits.

1.1 Scope of supply

The EVAL-6EDL041065PR evaluation board is delivered along with six TRENCHSTOP™ IKDO6N60RC2 IGBTs and
an iMOTION™ 2.0 M1 interface connector.

The package also contains an auxiliary power supply to provide 15V; a Low Dropout Linear Voltage Regulator
(TLE42744) to provide 3.3V; a voltage divider for DC-link voltage measurement; a single shunt for current
sensing and overcurrent protection.

1.2 Block diagram

Figure 1 shows a typical application diagram of EVAL-6EDL041065PR for driving a BLDC motor. The system
adopts a single-shunt configuration, which is prevalent for current BLDC motor drive applications.
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Figurel Typical application block diagram of EVAL-6EDL041065PR

The functional blocks of EVAL-6EDL04I065PR are presented in Figure 2.
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1.3 Main features

The main features of EVAL-6EDL04I065PR includes:

e 6EDLO04I065PR gate driver IC

e Nominal DCinput voltage of 300V

e Design for maximum 380W motor power output

e Single shuntfor current sensing

e Sensing of DC-link voltage

e +15Vand +3.3Vauxiliary power supplies on the board

e Ml interface compatible with the iIMOTION™ control board
e 6XTRENCHSTOP™ IKDO6N60RC2 IGBTSs

1.4 Board parameters and technical data

The key specifications of EVAL-6EDL04I065PR are listed in Table 1.
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Table1 Specification of EVAL-6EDL041065PR

Parameter Symbol | Conditions Value Unit

Min. ‘ Nom.l Max.

Input

Input voltage Vin DC voltage - 300 | 400 |V
Input current Iin Input current - 1.2 - A
Output

Output current lour RMS current - - 1.2 |A
Output power Pour - - 380 |W
Overcurrent protection loce - 2.9 - A
Switching frequency

Inverter carrier frequency | Fsw - - 25 | kHz

Auxiliary power supply

Gate driver power supply | Vcc - 15 - |V
Controller power supply - 3.3 - |V
System environment
Ambient temperature With adequate cooling method - 25 - |°C
PCB characteristics
L Length - 84 - | mm
Dimensions W Width - 55 - mm
H Height - 30 - |mm
Layer - 2 -
PCB thickness - 1.5 - |mm
Copper thickness - 1 - oz
Material FR-4, RoHS-compliant
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2 System and functional description

2.1 Getting started with EVAL-6EDL041065PR

To run the motor system, a combination of the power board EVAL-6EDL04I065PR and a matching iMOTION™
control board (EVAL-M1-101T) are required. This chapter explains how to set up the system and get started with
the iIMOTION™ development platform.

The power board EVAL-6EDL041065PR can run a BLDC motor by connecting to the iIMOTION™ 2.0 control board
EVAL-M1-101T through an M1 interface. The system is shown in Figure 3, and the results are listed in Section 4.

U/V/W phase-out

11

.

24443

EVAL-M1-101T| +—> oo [0 i 2 x DC input

3

Figure3  The system connection for running a BLDC motor

2.1.1 The iMOTION™ control board

You can order the Infineon control board EVAL-M1-101T from
https://www.infineon.com/cms/en/product/evaluation-boards/eval-m1-101t/ and download the latest
IMC101T-T038 MCE software package from www.infineon.com/imotion-software.

After obtaining EVAL-M1-101T and the latest software, connect your PC to the control board via a USB cable to
program and tune it.

1. Connect EVAL-M1-101T’s M1 20-pin interface connector J2 to the power board connector J5.
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2. In the MCEWizard, enter the system and operating parameters of the target motor and the hardware
parameters of the evaluation board. This data is used for calculating the digital parameter set of the controller,
representing the complete motor drive system.

3. Go to the Verify & Save page and click Calculate Parameters. Then, save the drive parameter set into your
project directory by clicking Export to MCEDesigner file (.txt) (see Figure 5). This saved drive system
parameter file will be used later by the MCEDesigner. Refer to Section 2.1.4 or the MCEWizard user guide for
more information.

4. Connect motor phase outputs (J2 on the power board) to the motor.
5. Connect AC input to the power input connector (J3 on the power board), then power on the system.
6. Start the MCEDesigner tool.

7. Click File > Open to open the MCEDesigner default configuration file (.irc) for the IMC101T-T038 controller
(IMC101T_Vxxx.irc). The IMC101T_Vxxx.irc file is included in the IMC101T-T038 MCE software package.

8. The MCEDesigner should automatically connect to the EVAL-M1-101T control board using the default COM
port (indicated by a green circle next to the “COMx Up” status in the bottom frame of the MCEDesigner GUI). If
the connection cannot be established, change the COM port as follows:

a) Open the System Page window.
b) Click Preferences>Connection>Connect using.
c) Choose one of the other available COM ports from the drop-down list.
9. Program the system parameters into the internal SRAM of the iMOTION™ IC using the following steps:
a) Click Tools>Programmer and select Program Parameters

b) Browse and select the System Drive Parameters file created in step 3. See section 2.1.4 for more
information.

10. Start the motor by clicking the green traffic light button in the control bar. To stop the motor, click the red
traffic light button in the control bar.

2.1.2 iMOTION™ development tools and software

The EVAL-6EDL04I065PR evaluation board can run a BLDC motor when connected to an external control board
EVAL-M1-101T. Users must configure the IMOTION™ development tool and software according to the system
and BLDC motor parameters.

The MCEDesigner and MCEWizard are based on MCEDesigner v2.3.1 and MCEWizard v2.3.1, and can be
downloaded together with supported files from http://www.infineon.com/imotion-software.

2.1.3 MCEWizard setup overview

Use the MCEWizard to configure the parameters for the evaluation board or motor. Figure 4 shows the Welcome
page of the MCEWizard. Here, users can select the control board or power board from a drop-down list. Infineon
releases new control and power boards regularly. Therefore, it is possible that some of the latest power boards
have not been pre-configured in the MCEWizard tool and cannot be selected from the drop-down menu. In that
case, users can select another power board (as similar as possible) and follow the setup steps in the MCEWizard
by entering parameters specific to the power board chosen. Please refer to the application note of the
corresponding power board for additional information.

After selecting the modular application design kit (MADK) control board and the power board, click Next in the
right-hand bottom corner of the Welcome page to start the MCEWizard system setup process.
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MCEWizard 2.3.0.1 — v
File JumptoPage Help
Welcome Page .

iMOTION™ 2.0 System Configuration Wizard

Using System Configuration File:
EVAL-M1-101T-05-65D.mc2

This motor control system is an
evaluation kit for complete inverter-
controlled motor drive applications
based on EVAL-M1-101T iMOTION
MADK controler board (based on
IMC101T-T038 iMOTION controller)
and EVAL-M1-05-65D MADK inverter
board (based on IRSM505-065DA2
CIPOS Micro IPM).

Following two options are available. =~ —
If no hardware change is done on this
board and there is no plan to change
default control settings:

Select > Default Hardware and Control

Settings. Get MADK Hardware Info Get iIMOTION™ Info

Previous Next

Figure4 Welcome page of the MCEWizard

The iIMOTION™ system enables users to easily test different combinations of control and power boards with
their motors. Users should be familiar with system-level parameters related to the motor used. There are a
limited number of parameters specific to the control board or power board hardware. Table 2 lists the
hardware parameters specific to the EVAL-6EDL041065PR power board for MCEWizard setup. Similar tables are
available for each control board in its application note. A combination of data in this table and the
corresponding table of the control board provides sufficient information to set up the motor drive system
quickly.
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Table 2 MCEWizard setup overview table

Parameters Value

Control board selecting EVAL-M1-101T (for example)

Motor 1 shunt configuration Single shunt

Controller supply voltage +3.3V

Max DC bus voltage 400V

DC bus sensing high resistor 2000kQ

DC bus sensing low resistor 13.3kQ (mounted on iMOTION™ board)

Gate sense low-side devices Highis true

Gate sense high-side devices High is true

Motorl current input scaling Calculated in the corresponding section of the
control board [4]

After all the MCEWizard questions are answered, the Verify & Save page opens (see Figure 5.).

B MCEWizard 2.3.0.1 — x
File JumptoPage Help
Verify & Save Page -
Verify Parameters
Calculate Parameters Display Parameters Results Export to MCEDesigner File (.b)

Double-Click an item to JUMP to its associated question

Previous Mext

Figure5 Verify & Save page of the MCEWizard

Click Calculate Parameters and then Export to MCEDesigner File (.txt) to save parameter file. This file will be
used by the MCEDesigner in the next steps.
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2.14 MCEDesigner setup overview

The MCEDesigner is a user interface to access or debug the control board. Open the MCEDesigner and then
open the IMC101T_xx.irc file. The main display page for EVAL-M1-101T opens, as shown in Figure 6.

E Motor1 nfineen Technologies

b 88

L] = | @B

®

ik C\Users\melegianiu
8 User Applicatior

#- M Start Motor
# H Stop Motor
=M Drive Status
M Emergency £
# @ Configure M
M Reference Sp

= @ Clear Faults

@ B VF Diagnost
%@ Read DC Vol
# @ Current Loof

#— B Speed Loop
¥ B Change Targ

LK = | @B
i C\Users\melegianiu
Monitor Definiti
#— @ FluxrAngle &
=B MotorSpeed
# B lu & Iv_Fast
@B lu & Iv_Slow
#-Bu & Flx_M
# B Fhe Q & Fli t
@ @ lu & MotorS
# Blu & Trg
= @ Status & Spe
@ @ Status & lu
¥ B FluxAngle &
= Bid & Ig
#— B Fhe A & Flx_E
=-Bvd & Vg
@ IdRef & Id
-

or Help, press F1 IMC101T COM4 Down|Trig Idle  *® Motor1 In:i ® System Inactive 4

Figure6  MCEDesigner’s main display for EVAL-M1-101T

After the drive system parameter file has been programmed into the IMC101 controller, and the motor drive
system powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change
the motor speed, modify drive parameters, and perform many other functions. Please refer to the MCEDesigner
documentation [6] for more details.

2.2 Description of the functional blocks

The motor inverter in EVAL-6EDL04I065PR hardware design is implemented by one 650V SOI three-phase gate
driver 6EDLO41065PR and six cost effective monolithically integrated IGBTs IKDO6N60RC2. The auxiliary power
supply adopts a monolithic integrated low dropout voltage regulator TLE42744GDV33.

2.2.1 Overview of 6GEDL041065PR

Figure 7 shows the functional block diagram of 6EDL041065PR. For more information such as static and
dynamic electrical characteristics of the gate driver, please refer to the datasheet of 6EDL04I1065PR.
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Figure7  Functional block diagram of 6EDL041065PR

The main features of 6EDL041065PR include:

e Infineon thin-film-SOI-technology

e Maximum blocking voltage +650 V

e Output source/sink current +0.165 A/-0.375 A

e Integrated ultra-fast, low Rpsion) Bootstrap Diode

e Insensitivity of the bridge output to negative transient voltages up to -50 V given by SOI-technology
e Separate control circuits for all six drivers

e Detection of over current and under voltage supply

e Externally programmable delay for fault clear after over current detection
e 'Shutdown' of all switches during error conditions

e CMOS and LSTTL compatible input (negative logic)

e Signalinterlocking of every phase to prevent cross-conduction
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Table 3 Absolute maximum rating

infineon

Parameter Symbol | Min. Max. Unit
High side offset voltage* Vs Ve - 650 vV
Vgs -1
High side floating supply voltage (Vs vs. Vs) (internally Ves -1 20
clamped)
High side output voltage (Vio vs. Vs) Vo -0.5 Ve+0.5
Low side supply voltage (internally clamped) Vee -1 20
Low side supply voltage (Vcc vs. Veom) Vecom -0.5 25
Gate driver ground Veom -5.7 5.7
Low side output voltage (Vio vs. Veom) Vio -0.5 Vecom +
0.5
Input voltage LIN,HIN,EN,ITRIP Vin -1 10
FAULT output voltage Veir -0.5 Vec+0.5
RCIN output voltage Ve -0.5 Vec+0.5
Power dissipation (to package)? Pp - 0.6 W
Thermal resistance Rin-a) - 165 K/W
(junction to ambient)
Junction temperature T, - 150 °C
Storage temperature Ts -40 150
Offset voltage slew rate? dVs/dt 50 V/ns

YIn case Vcc > Ve there is an additional power dissipation in the internal bootstrap diode between pins VCC and VBx. Insensitivity of
bridge output to negative transient voltage up to -50 V is not subject to production test - verified by design / characterization.

2 Consistent power dissipation of all outputs. All parameters inside operating range.

3 Not subject of production test, verified by characterization.
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2.2.2 Overview of IKDO6NG6ORC2

The IKDO6N60ORC2 is a cost effective monolithically integrated IGBT with diode for hard switching applications
from the TRENCHSTOP™ RC-Series.

Figure 8 shows the IKDO6N60RC2’s package and symbol. For more information about the IGBT, please refer to
datasheet of IKDO6N6GORC2.

C

LA
G

Figure8 Package and symbol of IKDO6NG6ORC2

The main features of IKDO4N60RC2 include:

e TRENCHSTOP™ Reverse Conducting (RC) technology for 600V applications

e Very tight parameter distribution

e Operating range up to 20kHz

e Maximum junction temperature 175°C

e Short circuit capability of 3us

e Humidity robust design

e Pb-free lead plating; RoHS compliant

e Complete product spectrum and PSpice Models: http://www.infineon.com/rc-d2

2.2.3 Overview of TLE42744GSV33

The TLE42744GDV33 is a monolithic integrated low dropout voltage regulator for load current up to 400maA.

Figure 9 shows the TLE42744GSV33 block diagram. For more information about the device, please refer to
datasheet of TLE42744GSV33.
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Figure9 Block diagram of TLE42744GSV33

The main features of TLE42744GSV33 include:

e Very low Current Consumption

e Output Voltages 5V and 3.3V +2%

e Output current up to 400mA

e Very Low Dropout Voltage

e Output Current Limitation

e Reverse Polarity Protection

e Overtemperature Shutdown

e Wide Temperature Range from -40°C up to 150°C
e Green Product (RoHS compliant)

e AEC Qualified
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3 System design

This chapter covers the hardware design of EVAL-6EDL041065PR in detail. Users can modify the circuit or
reselect the components values based on actual applications in the field.

3.1 Schematics

The schematic of EVAL-6EDL041065PR is shown in Figure 10.

Figure 10 EVAL-6EDL041065PR schematic

For more information about every block included in the schematic refer to the next sections.

3.1.1 Drive circuit with 6EDL041065PR

6EDLO41065PR gate driver IC is used to drive the six IKDO6N60RC2 IGBTs mounted on the board. The
configuration of 6EDL04I065PR is shown in Figure 11.

The capacitor C2 (C3, C9) is used as bootstrap capacitor to provide necessary floating supply voltage Ves.
Thanks to the 6EDL04I065PR integrated bootstrap diode, an external bootstrap diode is not needed.

6EDLO041065PR (high-voltage integrated circuit) HVIC is equipped with ITRIP input pin. This functionality can be
used to detect overcurrent events in DC bus. When the HVIC detects an overcurrent event through the ITRIP pin
for one of the three phases, the output (as well as the outputs of the other two phases) is shut down and the
FAULT pin is pulled to VSS to report the fault condition. The FAULT can also be used as the fault-clear time
programmable pin.

The fault-clear time setup is based on the datasheet of 6EDL041065PR. The main feature of 6EDL04I065PR
designed with Infineon’s SOI technology is its tolerance in terms of negative transient voltage in inductive load
applications. The device can tolerate repetitive negative transient voltage of up to 100V.
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Figure 11 Drive circuit design with 6EDL041065PR

3.1.2 Inverter section using IKDO6N60RC2

IKDO6N60RC2 TRENCHSTOP™ IGBTSs are mounted on the power board to implement the three-phase inverter
bridge section as shown in Figure 12.

R16 is single shunt for current sensing.

The inverter section slew rate and self heating performances can be seen in the corresponding paragraphs 4.3
and 4.4 respectively.
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Figure 12 Inverter section diagram

3.1.3 Overcurrent protection
The overcurrent circuit is shown in Figure 11 and Figure 12.

To save power loss of the shunt resistor, the RswuntValue is set as 150mQ (R16). In the design, the target for
overcurrent protection (loce) is 2.9A. The overcurrent threshold of the ITRIP pin is 0.445V (typical).

Considering the resistor Rs, is not mounted, the locp is calculated using the following simplified formula:

[ = Virrip _ 0445V _ oo,
OCP ™ Repunt _ 0.150Q '

Equation1l  Simplified equation to calculate the locp

If the Rs; would be mounted the loce can be calculated with the following formula:
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R1g+R4p + Rs1+ Rsp _ _(0.150 + 0 + 5100 +2000)Q _ . 7100.150
R1g Rs1 =0.445V (0.150 - 5100)Q =0.445V 7650

I
ocpr= VITRIP' =4.1A

Equation2 Complete equation to calculate the locp

3.14 DC-link voltage measurement

Bus capacitors (E6, C4) should be large enough to stabilize the bus voltage. A LED is mounted to flag when the
DC-link is applied to the board. The IMOTION™ controller can sense the DC-link voltage through the resistor
divider (R25, R26 and an additional pull-down resistor mounted on the iMOTION™ control board).

Note: The resistor R48 is not mounted on the power board EVAL-6EDL04I065PR because a pull-down resistor
is already soldered on the iIMOTION™ EVAL-M1-101T control board.

25 49
1M, 1% 90k
26
1M, 1% I:E*jﬂ
90k 13
DCINPUT
Eo_Lt ::(_ ! 2
ATuF 22nF, 500V 1
58
90k
DCBSense !\?B US OK
RED
48
NI
Figure 13 DC-Link schematic
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3.15 Auxiliary power supply

The auxiliary power supply circuit adopt a DC/DC converter to step down the DC-Link from 300V to 15V.
Moreover, an additional Low Dropout Linear Voltage Regulator (TLE42744GSV33) is added to provide a 3.3V
reference from 15V.

3.2 Layout

3.2.1 Layout details

Detailed layouts of the power inverter board are shown in Figure 14 and Figure 15.

< 2200m1l >

EUAL-SEDLO4I065PRM1 A
Rev. 1
20240408

3300mil

E:I::I:J"

(XX LX)
-t W=

Jca3

—-
w
K
o
|
-
[

Pl
R45 H-- ! -

Figure 14 Power inverter board layout (top view)
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Figure 15 Power inverter board layout (bottom view)

3.2.2 Layout guidelines
Some basic layout guidelines are as follow:

e TheVcc and Vs bypass capacitors should be close to the IC
e Thedrive loop should be as small as possible

e The loop of Vssand COM should be made as small as possible by connecting the Vss and COM directly at the
shunt-resistor terminals

e Thetwo current-sensing traces should be started from the shunt terminals and placed close to each other
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3.3

Bill of material

The complete bill of material is available on the download section of the Infineon homepage. A log-in is
required to download this material.

Table 4 BOM of the most important/critical parts of the evaluation or reference board
S.No. | RefDesignator Description Manufacturer | Manufacturer P/N Populated
1 U3 Three-phase Infineon 6EDLO041065PR Yes
gate driver with | Technologies
overcurrent
protection
2 Q1,Q2,Q3, 04, Q5, | Cost effective Infienon IKDO6NGORC2 Yes
Q6 monolithically | Technologies
integrated IGBT
with diode
3 u2 Monolithic Infineon TLE42744GDV33 Yes
integrated low | Technologies
dropout
voltage
regulator
34 Connector details
Table5 Connectors
PIN Label Function
DC+, DC- J3 DC power supply input
u,v,w J2 Three phase-outs (U/V/W) to the motor
J5 iMOTION™ MADK-M1 20-pin interface
connector
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Table 6 iMOTION™ MADK-M1 20-pin interface connector for controller board

Pin Name Pin name connectors

1 PWMUH 3.3V compatible logic input for high side gate driver-Phase U

2 GND Ground

3 PWMUL 3.3V compatible logic input for low side gate driver-Phase U

4 GND GND ground

5 PWMVH 3.3V compatible logic input for high side driver-Phase V

6 +3.3V On board 3.3V supply

7 PWMVL 3.3V compatible logic input for low side gate driver-Phase V

8 +3.3V On board 3.3V supply

9 PWMWH 3.3V compatible logic input for high side gate driver-Phase W

10 |_U Positive current sense output

11 PWMWL 3.3V compatible logic input for low side gate driver-Phase W

12 I_U- Negative currente sense output or ground

13 GK Gatekill signal - active low when overcurrent is detected

14 DCBSense DC bus positive voltage, scaled in 0-3.3V range by a voltage
divider

15 VTH Thermistor output

16 |V Not used

17 | V- Not used

18 I_W Not used

19 I_W- Not used

20 VCC 15V power supply
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4 System performance

EVAL-6EDL041065PR is tested while running a BLDC motor in the setup shown in Figure 16.
Test conditions:

e InputVi\=300VAC

e Phase-out current: lppase=714mA rms (@200rpm)

e Room temperature

e BLDC motor: Golden Age GK6040-6AC31-WE, test at speed =200r/min
e Three-phase sinusoidal modulation

o AR %

L\80 N
0L

TO PC VPHASE

iIMOTION™ To DC Power Supply

Figure 16 System setup for running a BLDC motor

4.1 The output phase current

Figure 17 shows the waveforms when running a BLDC motor.
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Figure 17 Phase U output current 714mA rms waveform at Viy=300VDC, Fs,=7TkHz

4.2 Test result for short-circuit protection

Figure 18 shows the short-circuit protection of EVAL-6EDL041065PR. The total short-circuit protection delay
time (including external RC filter, 2kQ/1nF) is less than 1 microseconds when the input voltage Vi is 300V and
the maximum current is about 29A.

30A
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20 $2 e .
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-500 ns oh 500 ns 1us 15us 2ps 25us 3us 35ps 4ps 45ps
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5.00 V/div 10.0 A/div. 10.0 V/div| 5.00 V/div t 500 ns/divf Normal 3.50 V
450 mV 10.00 A -20.00 V -18.30 VH : 50 kS 10 GS/s|Edge Positive

Figure 18 Short-circuit protection at Viy=300V

4.3 Slew rate performances (butterfly diagram)

Figure 19 shows the EVAL-6EDL04I065PR slew rate performances over phase current. The butterfly diagram
takes into consideration both High-side and Low-side, turn-on and turn-off conditions.
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Figure19 EVAL-6EDLO041065PR butterfly diagram

4.4 Self heating performances
Figure 20 shows the 6EDL041065PR gate driver and IKDO6N60RC2 IGBTSs self heating during motor control
operations.

The measurement refers to 200rpm motor target speed (7TkHz PWM frequency) at room temperature.
6EDLO4I065PR gate driver reaches 50°C while IKDO6N60RC2 IGBTSs reach less than 75°C as maximum

temperature.

Figure 20 EVAL-6EDLO041065PR self heating performances
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A Abbreviations and definitions

Table7 Abbrevations

(infineon

Abbrevation

Meaning

IC Integrated circuit

IGBT Insulated gate bipolar transistor

DC Direct current

BLDC Brushless direct current

PWM Pulse width modulation

EVAL Evaluation board

PCB Printed circuit board

SOl Silicon on insulator
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